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1 · · · Introduction 
With Digital Space Traveler (or simply "Traveler"), groups of people are able to talk with their own voices 
through expressive and animated avatars in three-dimensional virtual communities over the Internet. 
(Avatars are on-line 3D models that people use to personify themselves while online in a Traveler session.) 

Natural conversations are achieved through low latency, full-duplex, real-time voice technology over 
TCP/IP networks, including direct dial-up or ethernet Internet connections. Through Traveler's 3D sound 
features, users are fully immersed in the virtual environments with realistic social dynamics.  

Digital Space Traveler works as a Netscape Navigator (3.0 or later) or Microsoft Internet Explorer (3.0 or 
later) Web browser helper application. To begin communicating over the Internet with your own voice, 
download and install Digital Space Traveler right away (see "Getting Started"). 

  

2 · · · Getting Started 
To get started using Digital Space Traveler, ensure that you have the proper equipment and that your sound 
and microphone equipment is properly configured. The following sections cover these areas. 

  

System Requirements 
To run Traveler, you will need the following hardware:  

• Pentium or Pentium Pro Multimedia PC--not a 486; not even a very fast 486  
• Windows 95 or above  
• A PPP Internet connection. SLIP connections are not currently supported.  
• Minimum of 16MB RAM (32MB RAM recommended for Windows NT 4.0)  
• Internet connection: either 14.4k bps modem, 28.8k bps modem (recommended), or LAN/ISDN 

connection  
• Microphone and speakers, or headset with microphone  
• Netscape Navigator (3.0 or later) or Microsoft Internet Explorer (3.0 or later)  
• Sound card and Windows driver  

Hardware Setup and Test 
Ensure that your hardware is properly set up to connect to the Internet. Check that your microphone and 
sound equipment work properly by reviewing the following sections. 



  

Checking Your Microphone and Sound Equipment 

It is important to verify that your microphone and speaker equipment are properly set up before going online
because without these two integral components, you will not be able to communicate. Check your 
equipment, as follows: 

1. From the Windows Start menu, select Programs/Accessories/Multimedia/Sound Recorder.  
2. From the Sound Recorder window, click on the red dot "record" button and speak into your 

microphone for a few seconds. When you have finished recording your voice, click on the black 
rectangle "stop" button.  

3. Click on the single black arrow "play" button to replay your recorded voice through your speakers 
(or headset). You should be able to hear your voice as you recorded it. If not, refer to the following 
section.  

  

Troubleshooting Your Sound System 

If you are not able to hear your recorded voice, check for a problem in one or more of the following areas: 

• Check the volume control on your speakers. Is the volume knob turned up?  
• Check the hardware. Are the speaker and microphone jacks tightly seated? Is the microphone 

plugged into the proper input jack on the sound card? (Be sure it is not plugged into a modem or 
speakerphone jack.)  

• Check the microphone configuration. Is the microphone selected as an input device for recording?
Check your configuration with these steps:  

1. Check the microphone's on/off switch, if there is one. Make sure the microphone is turned on
2. Double-click on the yellow speaker icon on the Windows taskbar (lower-right corner of the 

screen). A Volume Control window appears.  

(If the speaker icon is not present on your screen's taskbar, select Settings/Control 
Panel/Multimedia from the Windows Start menu. Check the "Show volume control 
on the taskbar" setting in the Playback panel of the Audio property page.) 

3. Select Options, then Properties. A Properties window appears.  
4. In the Adjust Volume for panel, select "Recording" and ensure that "Microphone" is checked 

in the list beneath the panel. (If not, then select it.)  
5. Press the "OK" button and the Recording Control window appears, similar to Figure 1 (the 

window may vary slightly depending on the installed card and driver).  
6. In the "Microphone Balance" controls area, ensure that "Select" is checked and that the 

"Volume" slider is set within the mid to high range.  

Figure 1 : Microphone Balance Panel (Part of Recording Control Window) 



 

  

Downloading and Installing Digital Space Traveler 
Download Traveler from Digital Space Commons Web site (http://www.digitalspace.com/index.html) and 
install it, as follows: 

1. Click on the Digital Space Traveler download link. When the Save As... window is displayed, 
indicate where to save the downloaded executable file.  

2. Double-click on the downloaded executable file.  
3. An InstallShield Self-extracting EXE window is displayed, prompting to continue installation. Press 

the "Yes" button, and the files begin to get extracted.  
4. The "Setup" installation screens are displayed. Follow the prompts, including choosing a destination

to install Traveler (or assume the default).  
5. When installation is complete, you are prompted to restart your computer. Traveler cannot be 

launched until you restart your computer.  
6. After restarting your computer, you should be ready to "Go Traveling"  

  

3 · · · Traveler in 7 Steps 
So you are excited, and want to be in Traveler now, and don't want to read through an entire user guide. 
We'll get you there, in just 7 easy steps. 



Fair warning though. The virtual community is a community unlike any other, so after going through these 7
steps, you may want to go "Back to the Basics". What you learn from the basics will enhance your virtual 
experience. 

Perform the following steps to get Traveling as soon as possible: 

1. Download and install Traveler on your Multimedia Pentium PC. (Refer to "System Requirements" to
be sure that you have the necessary equipment.)  

Note: If you have another application running that utilizes your sound card, you cannot run Traveler 
simultaneously. Close the other application before launching Traveler. 

2. Click on the Digital Space Traveler shortcut icon that was placed on your desktop during installation

Figure 2 : Digital Space Traveler Shortcut Icon 

 

3. A License Agreement window is displayed. After reading and agreeing to the agreement in full, press
the "I Accept..." button.  

4. In the displayed Choose an Avatar window you can choose and name an avatar, then press the "Lets
Go Traveling" button.  

5. The main Traveler window is displayed, with zooming colored rectangles against a black 
background, as Traveler finds the selected space (see Figure 4). You will be joining a "no-connected
space" which contains portals to take you into Digital Space Traveler. Choose a portal to take you 
Traveling! 

6. Eventually, the window displays a space inside the Traveler community. You may see other avatars 
floating around the space, provided there are avatars in the room (if not use the "where is everyone in
this community...." to find and occupied space.)  

7. Hold down the [Ctrl] key while speaking, and release it to hear others. (Refer to the "Speaking and 
Listening" section.)  

  

  

  

4 · · · Back to the Basics 
This section provides you with some basics, such as terminology, what to expect when you launch into your
first Traveler experience, and some first-time setup procedures.  



  

Terminology 
Digital Space Traveler experiences are undoubtedly new and different than any virtual experience that you 
have encountered before. It is important to give definition to some key terms related to your travels. If these
defined terms do not make complete sense to you right away, do not despair. They will soon--as soon as you
enter Traveler's virtual communities, experiencing Traveler first-hand. 

• Avatars are on-line 3D models that people use to personify themselves while in a Traveler session. 
Each Traveler user joining a virtual space is represented by an avatar model of their choice, which 
can then be moved around a space through navigational keystroke commands. You can customize 
avatars by adjusting their appearance (and voice pitch if you have a full-duplex driver and sound 
card) as well.  

• A community is a group of spaces collectively grouped together. Within a single community, 
avatars can move between different spaces by way of portals.  

• Spaces are 3D environments that you encounter when you enter a community, and again when you 
travel through different portals. They are the areas where you conduct your 3D virtual experience 
with other avatars. A space may vary dramatically in scenery, other avatars present, ambient sounds,
and floating or stable objects that represent portals or links.  

• User Spaces are spaces created by users when a regular space is too crowded, or when a user wants 
to hold a special event such as a discussion on a particular topic. They are temporary spaces in that 
they only exist as long as at least one avatar is in the user space.  

• Portals are virtual doors or entrances into other spaces, enabling you to travel quickly between 
spaces. There are two types of portals: regular portals and user portals. Regular portals are public 
portals established by the host of the Traveler site. User portals enable users to create user spaces (or
enter existing user spaces). Both types of portals are typically represented in a space by 3D graphical
objects (although the objects do not have to be 3D), depending on how the host of the Traveler site 
designed the space(s).  

• Links connect you to URL addresses on the Web, which may or may not be within the same Web 
site from where you begin your travels. Examples of some links could be an event calendar, or a 
related Web page. Links, like portals, are typically represented in a space by 3D graphical objects 
(although the objects do not have to be 3D), depending on how the host of the Traveler site designed
the space(s).  

  

What to Expect Once In Digital Space Traveler 
When you first launch Traveler, you are presented with the Choose an Avatar window, illustrating a default 
"New User" avatar. This avatar will be your on-line presence in a Traveler virtual community. 

Figure 3 : First Time New User Entrance 



 

From this window, you can go Traveling by pressing the "Lets Go Traveling!" button. The main Traveler 
window is displayed, with zooming colored rectangles against a black background, as Traveler finds a space
(Figure 4).  

Figure 4 : Main Traveler Window While Transitioning to a New Space 



 

  

Speaking and Listening 
After entering a space, use the [Ctrl] key to activate and deactivate the microphone, as follows: 

• When speaking - Press the [Ctrl] key. This action activates the microphone. The colored bars on the 
Microphone Signal Level Meter on the toolbar fluctuate as your voice level changes. Also when 
speaking, a red lips icon appears in your Windows taskbar (lower right corner of screen).  

• When not speaking - Release the [Ctrl] key. This action inactivates the microphone, indicated by a 
grayed Microphone Signal Level Meter.  

Figure 5: Microphone Signal Level Meter on Toolbar  

 

If you cannot hear people, or can only hear people faintly, you may be too far away from them. Refer to the 



section on "Navigational Keystroke Commands" to move your avatar closer to other avatars. 

Using the [Ctrl] key to activate the microphone is known as "Push to Talk" mode. By default, "Push to Talk
mode is on, requiring you to press the [Ctrl] key when speaking and to be heard by others. You can turn 
"Push to Talk" mode off, and be heard without having to hold down the [Ctrl] key. This option (to turn 
"Push to Talk" off) is only available if you have a full-duplex sound system (i.e., a full-duplex sound card 
and driver). Further, you should only choose to turn "Push to Talk" mode off if you are using headphones or
a headset (headphones plus a microphone). If you do not use headphones or a headset, everything you hear 
through your speakers is recaptured by your system's microphone, sending echoes to all other avatars in you
community space. 

To change this mode at any time, access the Microphone property page (select Settings from the Edit menu)
Uncheck the "Push To Talk?" check box. Then, press the "OK" button.  

Remember: You should only turn "Push to Talk" mode off if you wear headphones or a headset. 

  

Establishing Settings 
When you launch Traveler for the first time, the Microphone and Connection properties are already preset. 
These property pages enable you to adjust your microphone to your voice level and define your Internet 
connection speed, respectively. The following sections also discuss the Volume, Cache, and Text Message 
property pages. 

To access these property pages select Settings from the Edit menu. Changes made to the Volume, 
Microphone, Cache, and Text Message property pages take effect immediately upon pressing the "OK" 
button in a changed property page. Changes made to the Connection property page take effect the next time 
you "Go Traveling". 

  

Microphone 

The Microphone property page enables you to adjust your microphone settings to your voice level. The two 
panels, Automatic Setup and Manual/Advanced Setup, are described in the following sub-sections. (Also 
refer to the "Establishing Settings" section.) 

Figure 6 : Microphone Property Page 



 

  

Automatic Setup 

In the Automatic Setup panel, the Microphone Training Wizard button enables you to run an automatic 
microphone controls adjustment procedure. During the 6-step guided procedure, your voice level is reflected
in the Microphone Signal Level Meter (black box with a fluctuating yellow bar). When the procedure has 
completed, your microphone settings in the Manual/Advanced Setup panel have been automatically adjusted
to your voice level and background noises.  

After initially running the Microphone Training Wizard, you should not have to run it again, unless someon
in your space comments about not being able to hear you. In such a case, if you choose to run the 
Microphone Training Wizard while in Traveler, you will not be able to hear others, or be heard by others, 
during the microphone training.  

(Note that the Microphone Signal Level Meter also appears on the Traveler toolbar when you are in 
Traveler.) 

  

Manual/Advanced Setup 

The sliders in the Manual/Advanced Setup panel are automatically adjusted by running the Microphone 
Training Wizard. You can also manually adjust these sliders, or check/uncheck them while in Traveler by 



accessing the Microphone property page (select Settings from the Edit menu).  

Following is a description of the check box settings:  

  

• Use AGC? - This setting refers to using AGC, or Automatic Gain Control, to set a constant volume 
level for your voice when you speak into your microphone. This makes a whisper louder or a shout 
softer so that both have about the same volume when projected from another system's speakers. By 
default, this setting is checked.  

• Push To Talk? - This setting can be changed in full-duplex systems only. It refers to using the "Push
to Talk" mode while in Traveler, a mode that, when activated, requires you to push the [Ctrl] key 
while speaking and allows you to be heard by others. By default, this setting is checked. Refer to 
"Speaking and Listening" to learn more about "Push to Talk" mode. (Note that you should only 
inactivate "Push to Talk" mode if you are using headphones or a headset.)  

• Silence Detection? - This setting sends your voice only when the level is above that specified by the
Silence Threshold slider (which is set by the Microphone Training Wizard). By default, this setting i
checked.  

  

Connection 

There are two panels to the Connection property page: Connection Speed and Networking, which are 
described in the following sub-sections. (Also refer to the "Establishing Settings" section.) 

Figure 7 : Connection Property Page 



 

  

Modem Connection 

Select the type of Internet connection that you have. Then press the "OK" button. 

  

Networking with Firewalls 

If your connection is via a LAN, you may have a problem connecting if your site is protected by a 
"firewall." Attempt to "Go Traveling" with the "Use TCP for Voice Packets" option unchecked. If it does 
not work, try again with the "Use TCP for Voice Packets" option checked. If you are still having difficulties
contact your system administrator and provide the following information.  

Digital Space Traveler, by default, establishes an outgoing TCP connection to port 3060 of the Digital Space
Community Server and uses UDP as the transport for voice packets. UDP packets are sent to and received 
from server port 3060. In this case, when Traveler connects from inside a firewall to a server located outside
the firewall, the firewall must allow outgoing TCP connections to server port 3060 and bi-directional UDP 
packet flow to and from server port 3060.  

If you are connecting through a firewall, and your firewall is configured to allow a clear path for TCP but 
not UDP, you may use TCP for voice packet transport. (Select "Use TCP for Voice Packets" in Traveler's 
Connection property page in Figure 7.) With "Use TCP for Voice Packets" selected, the firewall needs to 



allow outgoing TCP connections to port 3060 only, and does not have to permit UDP traffic. Using TCP for
voice packets, however, may reduce the quality of your audio. 

  

Volume  

The Volume property page enables you to adjust the volume levels of ambient, effects, or other voice sounds
within a space. (Also refer to the "Establishing Settings" section.) 

Figure 8: Volume Property Page  

 

The volume settings are distinguished as follows: 

  

• Ambient - The background sounds you hear while in a space (other than sound effects or voice). 
Ambient sounds are typically specific to the space environment. An example of an ambient sound 
could be the sound of wind.  

• Effects - The special effect sounds associated with a particular space. Effects sounds are typically 
specific to an action or occurrence within a space environment. Examples of effects sounds could be
the sounds heard when two people collide in a space, or when a person enters or exits a space.  

• Speech - The voice level of others in a space. If you are having trouble hearing others in a space, thi
setting may be set too low. Drag the sliders in the different volume settings higher or lower 



according to your preferences. Check the "Sound active when Traveler is in background" option to 
hear conversations and ambient sound when your Traveler window is in the background or 
minimized.  

  

Cache 

The Cache property page contains settings related to your  Traveler cache. Figure 9 illustrates typical cache 
settings based on a normal installation of Traveler, assuming default paths were not changed during the 
Traveler installation. (Also refer to the "Establishing Settings" section.) 

Figure 9 : Cache Property Page 

 

The cache settings are described as follows: 

  

• Check URL - Depending on the selection, this setting tells Traveler when to update your cache 
folder contents: either "Once Per Session" or "Never". If "Never" is selected, the cache will never 
update old "cached" files with newer versions, which may cause problems with accessing certain 
spaces. Therefore, "Once Per Session" is the recommended setting.  

• Folder - Reflects the location of where Traveler cached files are saved.  
• Maximum Size % of drive - Indicates the maximum size percentage of cache that stores Traveler 



specific cached files, as a percentage of your hard drive. When this percentage point is reached, the 
cached files used the least are purged first. In general, however, none of these settings should require
resetting.  

  

Text Message 

The Text Message property page settings allow you to enable or disable the receipt of text messages from 
other people within the same space while in Traveler. (Also refer to the "Establishing Settings" section.) 

Figure 10 : Text Message Property Page  

 

If you leave the "Enable sound on receipt of a text message" option checked, you will be audibly notified 
through a "text message receipt" sound (e.g., ring sound) when you receive a text message. 

If you check "Disable receipt of any new text messages", and someone within your space attempts to send 
you a text message, s/he will receive the error message shown in Figure 11.  

If another user has checked "Disable receipt of any new text messages" and you try to send that user a text 
message, you will be informed that s/he cannot receive your message. 

Figure 11 : Error Message When Text Messaging Is Disabled 



 

(Also refer to the "Text Message Button" section.) 

  

Improving Performance 
Following are some ways to improve the performance of Traveler on your system:  

  

• The size of the main Traveler window affects how fast the graphics are rendered. The larger the 
window, the slower the rendering rate. Reduce your window size to improve performance.  

• Extra open windows and/or applications hinders the performance of Traveler. Close extra windows 
and applications to improve performance.  

• To see how your performance is being improved, note the change in the FPS (frames per second) rat
on the status bar. As the FPS rate increases, performance improves.  

User Interface 
Traveler's user interface is relatively intuitive after a few short journeys into Traveler virtual communities. 
The following section describes the user interface in great detail, starting off with the menus. 

  

Menus 

Many of Traveler's menus are also accessible using keyboard hotkeys, or toolbar buttons. Table 1 defines al
the commands found in Traveler's menus.  

Table 1: Digital Space Traveler Menus  

Menu  Command  Description  Hotkeys Toolbar 
Button 

File  Open  

Opens a Travel To dialog. By typing in a URL to a 
space, you can travel directly into a space. If the URL is 
a Web page, your Web browser displays the designated 
Web page instead.  

[Ctrl] 
[O]   



Travel To Start 
Space  

Quickly places you in a pre-specified "start space" as 
defined with the "Set Start Space" command. The default 
start space is Digital Space's Traveler Destinations Web 
page. Also refer to the "Settings" section for more 
details.  

---   

Set Start Space  
Allows you to set the space that you are in as your start 
space. You can then quickly return to your start space 
after traveling between many spaces.  

---  ---  

Create Shortcut  

Allows you to create a Windows shortcut file that you 
can store anywhere on your computer. When you 
double-click on the shortcut file, Traveler is launched, 
and you are entered into the space that the Shortcut was 
created for.  

---  ---  

 

Exit  Allows you to exit out of Traveler, and consequently the 
space you were in.  ---  ---  

Cut  [Ctrl] 
[X]  ---  

Copy  [Ctrl] 
[C]  ---  

Paste  

Standard text editing commands for cutting, copying or 
pasting text in text input areas of Traveler (e.g., profile, 
text messaging, email, etc.). The Copy and Paste 
commands are especially useful for copying text 
messaging history to a text file.  [Ctrl] 

[V]  ---  

Customize your 
Avatar  

Opens the Customize Avatar window where you can 
modify you avatar's appearance, emotion, voice pitch, 
profile, and start space URL. Refer to the "Customize 
Avatar Window" section for more details.  

[Ctrl] 
[A]   

Edit  

Settings  
Opens the Settings window where you can configure 
your microphone, connection, volume, cache, and text 
message settings.  

---  ---  

Toolbar  
Toggle control to hide or display the toolbar of the main 
Traveler window. If checked, the toolbar is displayed. 
Refer to the "Toolbar" section for more details.  

---  ---  

Address Bar  

Toggle control to hide or display the address bar of the 
main Traveler window. If checked, the address bar is 
displayed. Refer to the "Address Bar" section for more 
details.  

---  ---  

Status Bar  

Toggle control to hide or display the status bar of the 
main Traveler window. If checked, the status bar is 
displayed. Refer to the "Status Bar" section for more 
details.  

---  ---  

View  

Next  Places you in the next space, after using the "Previous" 
command.  ---   



Previous  Places you in the previously visited space.  ---   

Stop Transition  Stops a space transition and returns you to the space you 
were previously in.  ---   

 

Reenter  

Allows you to reload the current space. One reason you 
might want to reenter is to see a new avatar that may 
have entered your space, but one that you do not have art 
for already in your cache.  

---   

Where is 
everyone in this 
community...  

Opens the Where is everyone in this community... 
window that shows you who and where everyone is in a 
community. Refer to the "Where is everyone in this 
community... Window" section for more details.  

[Ctrl] 
[W]   

Map  

Opens the Map window which displays a map of where 
all avatars, portals (regular and user), and links are 
located within a space, relative to one another. Refer to 
the "Map Window" section for more details.  

---   

List of who's in 
this space  

Opens the List of who's in this space window, a list of 
people in the space that you are in. Refer to the "List of 
Who's in This Space... Window" section for more 
details.  

---   

Locate  

Create a user 
space...  

Allows you to create a user space from within a space 
that has user portals. Refer to the "What Are User 
Spaces?" section for more details.  

---  ---  

Portals  Portals  Displays available portals and links that you can access 
in a community.  ---  ---  

Add To 
Favorites...  

Allows you to create a Windows "Favorites" shortcut 
file of a space's URL, so you can quickly return through 
the shortcut.  

---  ---  
Favorites 

Open Favorites...  Allows you to open the Windows "Favorites" folder of 
shortcuts to spaces.  ---  ---  

Help Topics  
Launches an online Help Topics module with 
information on key topics and access to more 
information.  

---  ---  
Help  

About Traveler...  Displays a window with the copyright information and 
version number of your copy of Traveler.  ---  ---  

  

  

Toolbar 

The toolbar, which provides a shortcut to many of the commands found in the menus, is optionally displayed



at the top of the Traveler user interface. Some of the toolbar's features are: 

  

• To hide the toolbar, select Toolbar from the View menu to uncheck it. To display the toolbar, reselec
Toolbar from the View menu (checking it).  

• When you hold your cursor over the toolbar buttons, "tooltips" are displayed, defining what each 
button does. A description also appears in the status bar (located at the bottom of the main Traveler 
window).  

• The toolbar can be dragged to another area of your screen. Drag on a non-button area of the toolbar 
to a place outside of the main Traveler window (making it a "floating" toolbar).  

• You can change the size of a floating toolbar by dragging on its bottom or sides.  
• To bring a floating toolbar back into the main Traveler window, drag it back to the top of the 

window, or double-click on a non-button area of the toolbar. (If you have changed its size, you do 
not have to change it back to its original size first.) The toolbar is displayed in Figure 12. The button
that have corresponding menu commands are defined in Table 1. Other toolbar buttons are labeled in
Figure 12.  

Figure 12 : Floating Toolbar  

 

  

Address Bar 

The address bar lists the URL of the space that you are in at any given time while in Traveler. If you jump 
around between spaces, a collection of space names where you have been are stored (within the same 
connected session only), and retrievable through the small downward arrow on the right-side of the address 
bar. By selecting a space name, you can return to a space that you were previously in. 

You can also type in a URL of a space into the address bar. Then press the [Enter] key. You will travel to 
the space specified, or your Web browser will open to a Web page, if applicable, and place the Traveler 
window in the background; the Traveler connection will be maintained. 

  



Status Bar 

The left-side of the status bar at the bottom of the main Traveler window displays status messages. 
Following is a list of typical status messages: 

• The status of a transition as you travel to a new space.  
• The name of an avatar that you place your cursor over within the main Traveler window or the Map

window.  
• The name of a portal or link that you place your cursor over within the main Traveler window or the

Map window.  
• Text messaging status when receiving or sending a text message.  

On the right-side of the status bar is: 

• The FPS (frames per second) drawing rate for the main Traveler window, as you move between 
spaces, and the scenery is changed.  

• The number of avatars in a space.  
• The progress when transitioning from space to space.  

  

Traveler Destinations Web Page 
At  the Digital Space Traveler Destinations web page, you will find a number of virtual communities listed,
which will differ in look, color, style, feel, and purpose. Each site contains spaces to explore and to meet 
many different people.  

You can also access the Traveler Destinations Web page by pressing the linked button (Traveler icon) on 
the toolbar, as follows: 

 

If you know a URL of a Traveler space, you can access that space directly from within your Web browser 
without having to go to the Traveler Destinations Web page first. 

  

Getting Help 
Following are some ways to get help while using Traveler. 

  

• On-line help accessed through the Help menu.  
• Digital Space Traveler Start page and other helpful resources accessed through 



http://www.digitalspace.com/traveler/startpage.html 

  

  

5 · · · All About Avatars 
When you travel between virtual spaces, you are personified by an on-line 3D model known as an "avatar". 
You can customize an avatar by modifying its appearance (or voice pitch if you have a full-duplex driver 
and sound card) at any time during your travels, in addition to expressing emotion. 

The following sections describe how to select and name your first avatar, create new avatars, customize 
existing avatars, and delete named avatars. 

  

Your First Avatar Model 
Before entering a space the first time in each Traveler session, the Choose an Avatar window is displayed. 
Figure 13 illustrates this window for first-time users before transitioning into a space, whereby a "New 
User" avatar model is displayed. At this point, you can "Go Traveling!" with the shown "New User" avatar, 
or create a new one. 

Figure 13 : Choose an Avatar Window 



 

If you "Go Traveling!" with the "New User" avatar, the avatar will look like the 3D model shown, and the 
avatar's name will appear as "New User" to all others already in Traveler.  

To create a new avatar with a new name or different model and appearance, from the Choose an Avatar 
window, press the "Create New..." button. A Save to New Avatar window appears, where you can name a 
new avatar.  

Figure 14 : Save to New Avatar Window  

 



Type in a name for the avatar you are creating. The name you choose becomes the name that all others in a 
space will know you by while in Traveler. After pressing "OK" in the Save in New Avatar window, the 
Customize Avatar window is displayed, which is described in the following section. 

If you create multiple new avatars, when you launch Traveler, you can use the pull-down "Known As" list to
select from the names of avatars that you have created. Also note that when you create a new avatar, the 
profile of the avatar selected in the "Known As" field is copied to the new avatar you are creating (although 
you can modify the profile through the Profile property page). Refer to the "Profile" section. 

  

Customize Avatar Window 
You can customize many different attributes of an avatar while in Traveler (or off-line too). Access the 
Customize Avatar window in one of the following ways:  

1. Select the Customize your Avatar command from the Edit menu; or  
2. Press [Ctrl] [A] from within the main Traveler window; or  
3. Press the "Customize your Avatar" icon button on the toolbar, as follows:  

 

4. If you are not in Traveler, upon launching into the Choose an Avatar window (Figure 13), press the 
"Edit" button. The Customize Avatar window is displayed with access to five tabbed property pages.
Common to the property pages are the following components:  

o Previewing your avatar from all sides - Drag on the vertical or horizontal sliders adjacent to 
the avatar preview window to view an avatar from different angles. You can tilt the avatar up
or down, or rotate it horizontally (up to 360 degrees).  

o Previewing avatar emotions - While in Traveler, you are able to display emotion through 
your avatar. Select different avatar emotions (located beneath the avatar preview window) to 
preview what your avatar's different emotions will look like.  

The following sections describe the Customize Avatar property pages' other components in more 
detail. 

  

Avatar Models 

Through the Avatar Models property page, you can select and preview different avatar models, or delete old
avatar sub-themes that have become unsupported over time.  

Figure 15 : Selecting an Avatar Model  



 

Click on different avatar models from the list(s) to view the models in the preview window. Select an avatar
to be your on-line presence in the spaces that you visit. 

Over time, avatar "sub-theme" directories (i.e., grouped directories) may become unsupported by a Traveler
site that first introduced them. You will know when a sub-theme is no longer supported because you will 
receive an error message when you attempt to select an avatar within an unsupported sub-theme directory. In
this case, delete a sub-theme directory by right-clicking on the sub-theme directory and selecting "Delete". 
Note that you can typically delete any sub-theme directory except "Standard Avatars". Also, you can only 
delete avatars individually if they exist under the root directory, and not in a sub-theme directory.  

One other feature available in the Avatar Models property page is the ability to display a "Properties" 
window of selected avatars (avatars released with Traveler 2.0 or later only). Select an avatar, right-click, 
then select "Properties". As you will notice, displaying "Properties" is only available for avatars, not avatar 
sub-theme directories. 

Any changes made in the Avatar Models property page while in Traveler take effect immediately upon 
pressing the "OK" button. 

  

Appearance 

Through the Appearance property page, you can modify the colors and shape of your selected avatar while 
previewing it from different angles and with different emotion. 

Figure 16 : Modifying Your Avatar's Appearance  



 

The components of the Appearance property page are: 

• Modifying an avatar's colors - Drag different color swatches from the color palette onto the avatar in
the preview window. To revert back to the avatar's original colors, press the "Set to Default Colors" 
button.  

• Modifying an avatar's shape - Drag the shape slider up and down to "stretch" or "squash" the avatar,
respectively.  

Any changes made in the Appearance property page while in Traveler take effect immediately upon 
pressing the "OK" button. 

  

Profile 

Through the Profile property page, you can create a profile to be associated with each named avatar that you
create.  

Figure 17 : Creating a Personal Profile to Be Associated with an Avatar  



 

The information entered into the Profile property page can be viewed by all others in a community while in 
Traveler. Although profile information is optional and specific to each created/named avatar, it becomes 
quite useful to others while in Traveler. Often, the profile becomes a starting point for discussions between 
others within a space. 

Enter your profile information by typing into the different fields, using the [Tab] key to jump forward, or 
[Shift] [Tab] to jump backward between the fields. Note that the name used in the Profile property page, and
the name of your avatar are not the same, unless you make them the same. 

Any changes made in the Profile property page while in Traveler take effect immediately upon pressing the 
"OK" button.  

  

Voice 

Through the Voice property page, you can modify and test how your voice will sound to others while in 
Traveler. 

Figure 18 : Modifying How Your Voice Will Sound to Others 



 

If you have a full-duplex system (i.e., full-duplex sound card and driver), you can hear what your voice will 
sound like while in Traveler (you must already be in Traveler), and adjust its pitch as desired. To try this, 
speak into your microphone, and your voice is played back. Adjust the "Set Voice Pitch" slider to the right 
or left, then speak a few more words into your microphone. Your adjusted voice is then played back. 

Any changes made in the Voice property page will take effect immediately upon pressing the "OK" button.

  

Settings  

Through the Settings property page, you can define a starting space for your avatar.  

Figure 19 : Defining a Start Space 



 

The URL start space refers to the space where your avatar will start at the beginning of a Traveler session. 
The default start space is typically the main gateway of the Traveler site that you are entering. To change the
Traveler start space, you can type a URL to a space into the "URL of my Start Space" field.  

An easier method of setting a start space, however, is to use the "Set Start Space" command from the File 
menu. If you use this command, the URL in the Settings property page will be changed to reflect the 
designated start space. If you have multiple avatars defined, you can specify a different URL start space for 
each avatar.  

Any changes made in the Settings property page while in Traveler take effect immediately upon pressing the
"OK" button. 

  

Deleting a Named Avatar 
You can delete an avatar from the Choose an Avatar window (Figure 13) before going Traveling.  

Select the name of the avatar to be deleted from the pull-down "Known As" list. Then press the "Delete" 
button (on Choose an Avatar window, not keyboard). 

  

  



  

6 · · · Now That You Are in Digital Space 
Traveler                 
Once you have entered a Traveler space, you can navigate within it, and enter other spaces within a 
community with navigational keystroke commands. You can interact with and carry on discussions with 
other people in the same space.  

The following sections describe how to navigate your avatar around or between a space, and mechanisms to
interact with other avatars. 

  

Navigational Keystroke Commands 
To explore within a community space, there are a number of navigational keystrokes to move your avatar 
through the space. Your view as you maneuver throughout the space is through your avatar's eyes--what 
your avatar sees--except when using the "third person perspective" keystrokes command. Table 2 lists 
navigational keystroke commands for Traveler.  

Table 2 : Navigational Keystroke Commands  
Navigational Action   Traveler 2.0 Keystrokes  

"Push-to-Talk"   [Ctrl]  
move forward   up arrow  
move backward   down arrow  
rotate left   left arrow  
rotate right   right arrow  
slide up   [Alt] up arrow  
slide down   [Alt] down arrow  
slide left   [Alt] left arrow  
slide right   [Alt] right arrow  
pitch backward   [Page Up]  
pitch forward   [Page Down]  
roll left   [Insert]  
roll right   [Delete]  
move faster (to be used in combination with all 
preceding commands)   [Shift]  



realign horizontally   [End]  
return to entry point   [Home]  
third person perspective (4-way toggle)   [Ctrl] [I]  

Go near a selected avatar   

Double-click on:  
•  an avatar in main Traveler window  
•  a name within List of who's in this space... 
window  
•  a head icon within Map window  

Quick enter into a portal   

Double-click on:  
•  a portal object in main Traveler window  
•  a space name within Where is everyone in 
this community... window  
•  a portal icon within Map window  

Quick open a link (in Web browser)   
Double-click on:  
•  a link object in main Traveler window  
•  a link icon within Map window  

  

  

Interacting with Other Avatars 
After you enter a space, the right-side of the status bar tells you how many people are in the space. When 
you see other avatars, by placing your cursor over them, the status bar reflects the avatar's name that you are
"pointing to". Similarly, if you place the cursor over portals or link objects, the status bar tells you what 
portal or link that you are pointing at. (Portals can come in many different guises, depending on how a 
community's graphics are designed.) 

To speak to someone else within a space, you need to be in close range of their avatar. Similarly, if 
someone's avatar is near you, and they speak, you'll be able to hear them. If you are too far away, even 
though you are both in the same space, your voice may be too soft for them to hear you. Using the 
navigational commands described in Table 2, you can move closer to other avatars within a space. To speak
press the [Ctrl] key. When not speaking, release the [Ctrl] key. (Refer to "Speaking and Listening" for other
options regarding speaking in a space.) 

  

Map Window 

To get a perspective of where all the avatars, portals, and links are within a space, press the "Map" button on
the toolbar (or select Map from the Locate menu), as follows: 



 

A window similar to Figure 20 is displayed. While the Map window is open, you can navigate your avatar, 
represented by the centered triangle, within the space using the navigational keystrokes. See how your 
movements affect your position in the space, relative to the space and others.  

Figure 20 : Map Window of Where Everyone Is in a Space 

 

Following is a list of functions that can be invoked from the Map window (refer to "Map Key" in Figure 20)

• Drag the scale slider to display avatars or portals that are out of the map range.  
• Place the cursor over any head icon. The status bar shows who you are pointing to.  
• Place the cursor over a portal, or a link icon. The status bar shows you what portal or link you are 

pointing to.  
• Double-click on any head icon to quickly move near the selected avatar.  
• Double-click on a portal to enter the selected portal.  
• Double-click on a link icon and your Web browser opens the linked Web page.  

  

List of who's in this space... Window 



To see who's in a space that you are in, press the "Show list of who's in this space" button on the toolbar (or 
select the "List who's in this space..." command from the Locate menu), as follows: 

 

A window similar to Figure 21 is displayed. 

Figure 21 : List of who's in this space... Window 

 

From this window, button options are available for interacting with others in the space. Before pressing a 
button, select (single-click) a name from the list. The button option functions can also be invoked through 
right-clicking on a name, which displays a short menu. 

The button options are described in the following sections.  

  

Go Near Button 

By pressing the "Go Near" button, your avatar quickly moves near the avatar of the selected name. Other 
ways to quickly navigate your avatar near another are as follows: 

• Double-click on a name in the List of who's in this space... window.  



• Press [Alt] [G] after selecting a name in the List of who's in this space... window.  
• Right-click after selecting a name in the List of who's in this space... window, and select "Go Near" 

from the shortcut menu.  
• Right-click on an avatar in space and select the "Go Near" command.  

  

Ignore Button 

The "Ignore" button allows you to ignore someone in a space that may be bothering you or that you do not 
want to listen to. When you ignore someone, you will not be able to hear anything that person says, nor can 
you receive any text messages from that person. However, if the ignored person were to send you a text 
message, they would not be notified that you did not get it, or that you are ignoring them. When you ignore 
someone, their head icon becomes crossed in your List of who's in this space... window, as follows:  

 

If you reselect an ignored name, the "Ignore" button reflects "Unignore" instead. Turn the ignored state off 
by pressing the "Unignore" button. 

You can also toggle the "Ignore/Unignore" functions by pressing [Alt] [I] after selecting a name in the List 
of who's in this space... window. 

  

Text Message Button 

Text messaging enables you to send a short text message to someone else within the same space while in 
Traveler. Text messaging is private between the two users involved in a text message discourse. Following 
is how text messaging works:  

1. After selecting a name from the List of who's in this space... window, press the "Text Message" 
button. A dialog window with a thumbnail image of the selected avatar is displayed, along with a 
white text input area.  

2. Type in the white area (maximum of 80 characters between "sends"), then press the "Send Message"
button. The recipient is alerted of the text message by an alerting sound. The Text Message dialog 
window appears on their screen (and closes on yours).  

3. The recipient may write back, and press the "Send Message" button.  
4. You are alerted of the new message by an alerting sound. Also, the status bar at the base of the 

Traveler window reflects who has sent the text message to you.  

The history of the text message discourse is saved in the area above the input area. Figure 22 displays a text 
messaging that went back and forth a few times.  

Figure 22 : Text Messaging Dialog Window 



 

If the users end their text messaging, but then resume a discussion later while in the same space, the text 
history remains, and new text messaging is appended. The text message history is cleared if you leave the 
space, or reenter; the history in the other person's Text Message window is retained, until they leave the 
space, or reenter. If the person you were text messaging with leaves the space, and you still have the Text 
Message window open, the "Send Message" button reverts to "User has left the space".  

If you would like to save the history, drag to highlight the text, then use [Ctrl] [C] to copy it to a clipboard. 
Use [Ctrl] [V] to paste the text into another application that accepts text. If the same Text Message window 
is then closed, the history is gone forever and cannot be retrieved. If you send a text message to someone 
else in the space, a new Text Message window is created.  

For additional settings involving text messaging, refer to the "Text Message" section. 

  

Profile... Button 

By pressing the "Profile..." button after selecting a name within the List of who's in this space... window, you
can view the profile of the person associated with an avatar. You can see name, city, birthdate, email 
address, Web page URL, and any other information they have provided. 

Following are some other options for reviewing profiles: 

• Right-click on an avatar in the space and select the "Show Profile..." command.  
• Right-click on a name in the List of who's in this space... window, and select the "Show Profile..." 

command.  
• Press [Alt] [P] after selecting a name in the List of who's in this space... or Where is everyone in this 

community... windows.  
• Right-click on a head icon in the Map window, and select the "Show Profile..." command.  
• Double-click on a name in Where is everyone in this community... window (with any space selected)

  



Send Email Button 

The "Send Email" button allows you to send email to individuals in the same space who have specified their
email address in their profile. If an email address is defined and you press "Send Email", your email 
application is launched. 

Following are some other options for sending email: 

• Right-click on an avatar in space and select the "Send Mail To..." command.  
• Right-click on a name in the List of who's in this space... window, and select the "Send Mail To..." 

command.  
• Press [Alt] [E] after selecting a name in List of who's in this space... or Where is everyone in this 

community... window.  
• Right-click on a head icon in the Map window, and select the "Send Mail To..." command.  

If an email address is not specified in a profile, and you attempt to send that person email anyway, the 
following error message is returned. 

Figure 23 : Cannot "Send Email" Because No Email Address Is Defined in Profile  

 

  

Web Page Button 

The "Web Page" button directs your browser to open the Web page of someone you have selected who has 
specified a Web page in their profile. If a Web page URL is not specified in their profile, and you had 
pressed the "Web Page" button, the following error message is displayed. 

Figure 24 : No Web Page Defined in Profile  

 



Following are some other options for viewing Web pages: 

• Right-click on an avatar in space and select the "Show Web Page..." command.  
• Right-click on a name in the List of who's in this space... window, and select the "Show Web Page...

command.  
• Press [Alt] [W] after selecting a name in List of who's in this space... or Where is everyone in this 

community... window.  
• Right-click on a head icon in the Map window, and select the "Show Web Page..." command.  

  

Where is everyone in this community... Window 

To see where everyone is within a community, press the "Where is everyone in this community..." button on
the toolbar (or select Where is everyone in this community... from the Locate menu), as follows: 

 

Figure 25 is an example of a Where is everyone in this community... window. 

Figure 25 : Where is everyone in this community... Window 

 

The window displays both regular and password-protected spaces; password-protected spaces are identified 
by a lock icon next to the space name. "Locked" spaces may or may not show the participants, depending on
how the space was set up (i.e., when creating a user space, you can block the participants from being 
viewable). 

Following is a list of functions that can be invoked from the Where is everyone in this community... window

• Click on any space name, and a corresponding list of people in that space appears in the People 



panel.  
• Double-click on a space name (or right-click on a space name and select "Join Space") to enter into 

the selected new space.  
• Double-click on a name within the People panel, and a profile is displayed.  
• After selecting a name in the People panel, the buttons in the lower right corner become active. Press

any of these buttons to invoke the labeled commands.  

  

Showing Emotion 
While talking with someone else in a space, you can express emotion through your avatar's expressions. The
emotions you can display are: happy, surprised, neutral (default), sad, and angry.  

  

Toolbar Emotions 

Press a toolbar emotion button to express emotion through your avatar. For example, if you are talking with 
another person who tells a joke, you can press the "happy" button after the punchline, and your avatar will 
smile. If the other person's avatar is near or in front of yours, they will see your avatar smile. If the other 
person says something sad, press the "sad" button, and your avatar will display a sad expression. 

Just as emotions are ever-changing and temporary with people, emotions are temporary with avatars. To the
left of the emotion toolbar buttons is an emotion level box. This box displays your avatar's emotion and its 
intensity by the color and level, respectively, as you press emotion buttons (one or multiple times). 
Eventually, the emotion level box returns to "no-color" when your avatar's emotion has returned to a neutral
state. 

  

Previewing Avatar Emotions 

Emotions also play a part in the property pages of the Customize your Avatar window. When you are 
modifying the appearance of your avatar, you can select different emotions to preview what your avatar will
look like while Traveler. Refer to the "Customize Avatar Window" section. 

  

Navigating from Space to Space 
There are many ways to navigate your avatar from space to space. The following list summarizes the 
different space-to-space travel options. 

• Enter a URL in the Travel To window via File/Open commands.  



• Double-click on a space name within the Where is everyone in this community... window (refer to 
"Where is everyone in this community... Window" section).  

• Double-click on a portal object.  
• Right-click on a portal object, and select the "Activate" command.  
• Select a portal from the Portals menu.  
• Create a new user space (refer to "What Are User Spaces?" section).  
• Select File/Travel to Start Space, or press the corresponding toolbar button (refer to  

Table 1).  
• Select View/Previous, or press the corresponding toolbar button (refer to Table 1).  
• Select View/Next, or press the corresponding toolbar button (refer to Table 1).  
• Double-click on a previously saved URL shortcut file from the saved "Favorites" shortcuts via the 

Favorites/Open Favorites command (refer to "Favorite Spaces" section).  
• Type in or select a URL from the Address Bar (refer to "Address Bar" section).  
• Click on a link to a 3D virtual community on a Web page (for example, "Digital Space Traveler 

Destinations Web Page").  

  

Traveler Shortcut Menus 
From within the Traveler window, there are shortcut menus that may be accessed by right-clicking in certain
areas of the user interface. Once a shortcut menu is displayed, the menu stays up (unless you click outside o
the menu), and you can make a selection by highlighting a menu item and then clicking the left or right 
mouse button. 

By right-clicking within a space, a shortcut menu like Figure 26 is displayed. Refer to Table 1 for further 
explanation of these menu items. 

Figure 26 : Right-Click Shortcut Menu When Cursor Is in Space  

 

By right-clicking when your cursor is placed over an avatar in a space or in the Map window, a shortcut 
menu like Figure 27 is displayed. Refer to the "List of Who's in This Space... Window" section for further 
explanation of these menu items. 

Figure 27 : Right-Click Shortcut Menu When Cursor Is on Another Avatar 



 

By right-clicking when your cursor is placed over a portal or link object in a space or in the Map window, a 
shortcut menu like Figure 28 is displayed.  

Figure 28 : Right-Click Shortcut Menu When Cursor Is on a Portal 

 

If you select "Activate", you will access the selected portal or link. "Go Near" brings you near to the portal 
or link object. If you select "Properties", a window similar to Figure 29 is displayed, showing the properties 
of the selected portal or link. 

Figure 29 : Portal Properties 

 

  

Favorite Spaces 
The Favorites menu offers the following commands:  



  

• Add to Favorites - Creates and saves a *.URL space shortcut file that includes the URL of the space
you are in at the time that you invoke the "Add to Favorites" command. This file is saved to the 
Windows "Favorites" folder, or any other folder that you designate when the Save As window is 
displayed.  

• Open Favorites - Opens the Windows "Favorites" folder, where you can select a previously saved 
space shortcut file.  

In addition, the Favorites menu includes the name of the space that you are in at any given time during your
travels. 

  

  

  

7 · · · What Are User Spaces? 
User Spaces are spaces created by users when a regular space is too crowded, or when a user wants to hold a
special event such as a discussion on a particular topic or a private discussion with a few friends. They are 
temporary spaces in that they only exist as long as at least one avatar is in the user space; they are deleted 
when the last avatar in a user space leaves the space.  

User spaces can be created whenever you are in a space that has user portals. To see if the space you are in 
has a user portal(s), access the Portals menu. A user portal is marked with a green bullet preceding its name
and is identified as a "User Portal".  

As an example, Figure 30 shows a user portal within the Portals menu. 

Figure 30 : Portals Menu, Including User Portals 



 

  

"Create a user space..." Menu Command 
Assuming that there is a user portal in the space you are in, select the "Create a user space" command from 
the Locate menu. (If there are no user portals in the space you are in, then the "Create a user space..." 
command is disabled.) The New Space window is displayed, as shown in Figure 31.  

Figure 31 : New Space Window  

 

Type in a name for your new user space. If you want to make the user space password-protected, check the 
"Require a password to enter this space" option, and then type in a case-sensitive password. You can restrict
the visibility of who's in your space when other users access the Where is everyone in this community... 
window, by selecting the "Don't show list of people..." option.  

Press the "OK" button and your new space is created and you are transitioned into it. The new space (e.g., 
"The Hut") appears in the Where is everyone in this community...window, so other avatars can join you in 



your new user space, as long as there is no password protection. 

Figure 32 : Where is everyone in this community.. Window Displaying Password  
Controlled User Space with List of People in User Space Remaining Anonymous 

 

When a space requires a password and a user attempts to enter, a Protected Space Password window is 
displayed, as shown in Figure 33.  

Figure 33 : Protected Space Password Window 

 

A user is allowed three tries to enter the correct, case-sensitive password. If they do not input the proper 
password, an error message is displayed. 

  

Entering a User Space 
Enter a user space in one of the following ways: 

• Select a user portal in the Portals menu; or  
• Double-click on a graphical user portal in your main Traveler window; or  



• Select a user space listed in the Where is everyone in this community... window.  

If you use either of the ways described in the first two bullets, and there is more than one user space created 
off of a single portal, a window similar to Figure 34 is displayed, listing other user spaces of the selected 
portal. 

Figure 34 : Where is Everyone in [User Portal Name] Window 

 

Within this window, you can select the user space that you want to access by double-clicking on a user spac
name (or highlight a user space name, and press the "Enter" button). If no other user spaces exist already 
(upon accessing the selected user portal), a window offering you an opportunity to create a user space is 
displayed. 

Figure 34 : No Public User Spaces Here 

 

If you press the "Create" button, the New Spaces window (Figure 31) is displayed, just as if you had selected
the "Create a user space..." command from the Locate menu. 

  



  

  

8 · · · Problems  
The following section addresses some problems that you could encounter with Traveler, and ways to work 
around or resolve the problems. 

  

Unable to Move an Avatar while in Traveler 
If you are in a space, and you cannot move your avatar, click inside the Traveler window to ensure that it is 
the active window. Sometimes, if you have extra windows open, it is possible to inadvertently make one of 
them the active window, instead of the Traveler window.  

  

Connecting 
On occasion, you may experience problems accessing a Digital Space community server. These problems 
could be:  

• The community that you are trying to access is full (maximum number of participants has been 
reached).  

• The server you are trying to access has been brought down for maintenance.  

In these cases, the problems are often temporary, and an error message may advise you to "...Please try again
later." When you try again later, you may be able to get in Traveler without incident. Otherwise, without 
waiting, you can try accessing a different community hosted by a different server. 

With other problems, such as packet loss due to heavy Internet traffic, noisy telephone lines, or other 
network problems, symptoms could be more dramatic: you get disconnected, or you experience broken and 
choppy voice quality. Following are two ways to help diagnose Internet problems, and to better understand 
the performance level problems between your computer and the Internet.  

• Using "ping". The ping program allows you to see how the Internet is performing, and if there are 
timeout problems. First, connect to the Internet. Then run the following "ping" command from the 
MS_DOS prompt in the Windows sub-directory:  

ping -n 100 -l 210 anyserver.com 



This command sends out 100 data packets, each being 210 bytes long (the size of an Digital Space 
voice packet), to Digital Space server. The server then bounces them back to your machine. The 
results from this command will show you how many packets it receives and how many packets are 
timed out. If there are a lot of packets timing out--like 8 or more for a modem connection, and 5 or 
more for a LAN or ISDN connection--then you know that the Internet is not doing well, at least at 
that particular moment.  

• Using "traceroute". If you find that your Internet connection is poor through the above "ping" 
command, use the traceroute program to chart your path through the Internet. First, connect to the 
Internet. Then run the following "traceroute" command from the MS_DOS prompt in the Windows 
sub-directory by typing:  

• tracert anyserver.com 

The traceroute program reports each Internet router hop and the time it took for your test to get there
If you see long pauses and high numbers next to the "ms" (milliseconds) label for some of the hops, 
that would indicate where the problems are in your connection. Sometimes the results of the 
"traceroute" command point directly to your Internet provider. If so, contact your Internet provider 
and let them know what you have learned through these commands so they can resolve the problem.

Sometimes these Internet-related problems are just temporary, due to Internet traffic, and if you try to log on
later, the problems could be gone. If the problems persist for an extended amount of time, contact your 
Internet service provider. 

  

 
  

  

1Generically referred to as just "Windows" throughout this guide. 
2Sound card that comes installed in shipped PCs. 
3Only user spaces created from a user portal in a VRML space can be password-protected (i.e., .dsv or .wrl 
extensions on the space's filename in the URL). Spaces with an .dss extension on the filename cannot be 
password-protected. 
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